
© HandicapMaster Limited 2023

ClubWebsite

User Manual



ClubWebsite
Club Website Content Management Software

by © HandicapMaster Limited 2023
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find this Manual to be of help.

We always value customer feedback. If you have any
comments about this manual, please do not hesitate to
contact us.

Should you need any additional assistance with ClubWebsite,
please do not hesitate to contact us.

Thank you.
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Web Site: https://www.handicapmaster.org
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1 ClubWebsite

ClubWebsite 
Online Help System

HANDICAPMASTER LIMITED
15 Adlington Drive

Sandbach
Cheshire

CW11 1DX

www.handicapmaster.org

support@handicapmaster.org

http://www.handicapmaster.org/
mailto:support@handicapmaster.org
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2 Introduction

Welcome to ClubWebsite. 

ClubWebsite is a content management program that enables you to publish, edit and modify content to
your club website, as provided by the HandicapMaster system.

Web content that may be published includes text and photos, tabular data and links to downloadable
documents (PDF documents). Content may also include special resources such as location maps,
“contact-us” forms, Club News items, Club open competitions, etc, provided by the system.

This content is placed on the “public” pages of your website; pages that may be accessed by any user
viewing the website.

You may also create a “members section” on the website in one action, which is automatically created
with your Master Scoreboard content, fully integrated into the website.

Easily add and update content

You have the freedom to update your content without delay or additional expense. When you make
changes to your website through ClubWebsite, these are immediately displayed on your website.

Change the structure of your website easily

Not only can you edit your content whenever you like, but you can also add new pages at any time,
delete pages or simply rearrange the order pages or sections appear in your navigation. 

Notes

ClubWebsite is provided as an option to the HandicapMaster program suite for golf clubs and societies
to manage their club's competitions and handicaps.

HandicapMaster and Master Scoreboard are the Registered Trademarks of  HandicapMaster Limited.
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3 How to buy HandicapMaster?

Product Summary
http://www.handicapmaster.org/products

Direct Order Link
http://www.handicapmaster.org/shop

Home page
http://www.handicapmaster.org/home.php

E-mail Support
support@handicapmaster.org

Address
HandicapMaster Limited,
15 Adlington Drive,
Sandbach,
Cheshire.
CW11 1DX.
United Kingdom

http://www.handicapmaster.org/products
http://www.handicapmaster.org/shop
http://www.handicapmaster.org/home.php
mailto:support@handicapmaster.org
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4 The ClubWebsite Desktop

4.1 Introduction

ClubWebsite is known for its neat and intuitive user interface. The heart of the program is the
Task or Folder pane alongside the Main Window pane. This is situated in the ClubWebsite

desktop.

Toolbars

The most common tasks in ClubWebsite may be accomplished using the buttons along the top of
the main desktop.

Other Toolbars become available for printing reports, writing letters, etc.

Context sensitive help

ClubWebsite has an extensive, context-sensitive help system. These can easily be accessed by
pressing Function Key F1 or clicking buttons labelled 'Help'
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4.2 What you will need to run ClubWebsite

To operate a club website with public access, you will need;

1. A subscription to ClubWebsite alongside your HandicapMaster subscription,

2. An account (whether used or not) set up on the Master Scoreboard system.

3. A web domain address that may be used to direct users to your website (HandicapMaster Limited
can provide one if needed).
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4.3 The Desktop

Below is the main ClubWebsite desktop. Scroll down for a detailed description.

Main Toolbar

The Main Toolbar, situated across the top of the ClubWebsite desktop, provides access to the
most common tasks such as creating a list of handicaps, producing a Handicap Certificate, etc.

Tasks/Explorer Tab

The Tasks/Explorer Tab lets you choose between displaying quick access to Tasks you may
wish to perform in ClubWebsite, or searching your records using a Windows Explorer style Tree
(not shown in the picture). Both of these are shown in the Left Hand Pane.

Left Hand Pane

This pane shows either
Tasks you may wish to perform, or
Explorer Tree to search and locate records in the database.

When showing Tasks you may wish to perform (as shown above), the 'popular' tasks from a given
subject i.e Handicapping, Membership or Competitions are displayed in the upper box. Click over any
Task listed, to initiate the task. The lower box shows links to other subjects in ClubWebsite.

For a more detailed view of the records in the database, click the Explorer tab. The left hand
pane now shows an Explorer Tree, with records categorised into folders and collections. Click
any item in the tree to display the applicable records in the Right Hand Pane.

Right Hand Pane

The Right Hand Pane shows the records in the ClubWebsite database. Depending upon the task
being undertaken, the data may be shown

as a list (as shown above) in a grid.
in a report that can be printed, for example, or
pictorially, as a graph on screen.
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5 Getting Started with ClubWebsite

5.1 Copyright and Warranty

Please carefully read the terms and conditions before using this software. Unless you have a
different licence agreement signed by HandicapMaster Limited your use of this software indicates
your acceptance of this licence agreement and warranty. 
 

Registered Version
A registered version may be freely replicated provided all uses of the copies remains with the sole
purpose of processing on behalf of the registered party. 
 

Reverse Engineering
You may not reverse engineer, de-compile or disassemble the software without prior agreement
of the author.
 

Database access
 You may not access the ClubWebsite database other than in the manner intended by using the
software provided. Direct access to the database using Microsoft Access or other software
without the authors prior consent is forbidden.
 

Disclaimer of Warranty 
THIS SOFTWARE AND ACCOMPANYING FILES ARE PROVIDED 'AS IS' AND WITHOUT
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER
WARRANTIES WHETHER EXPRESSED OR SUPPLIED. Because of the various hardware and
software environments into which ClubWebsite may be put, no warranty of fitness for a particular
purpose is offered. Good data processing procedure dictates that any program be thoroughly
tested with non-critical data before relying on it. The user must assume the entire risk of using
the program. Any liability of the seller will be limited exclusively to product replacement or refund
of any purchase price. 
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5.2 Getting Started

Before you can start using ClubWebsite

Before you can start to use ClubWebsite to build a club website, you will need to

1. Supply HandicapMaster Ltd with some static information for your website, such as a club logo or
crest for display on the site. This information would normally be supplied as part of purchasing a
new subscription to the ClubWebsite service.

2. Arrange for your web domain to be reconfigured to point to the Master Scoreboard service.
HandicapMaster Ltd can supply the details required for this or can provide a domain for you.

How to Start ClubWebsite

 

1. Do one of the following:
 

Select ClubWebsite from the Start Bar, or 
 

double-click over the Icon on the Desktop, or 
 

double-click over ClubWebsite.EXE from within Windows Explorer.

How to Log into ClubWebsite

 

1. Users are normally required to log on to ClubWebsite. The initial user name is Admin and no
password. 

 

2. The password may be changed by starting the main HandicapMaster program and choosing
the Change Password option from the File menu.

If you have lost the Password

 

1. In the event of the password being lost or forgotten, please contact the supplier.
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6 Using ClubWebsite

6.1 Introduction

After choosing Website settings, there are two primary functions that you will perform with ClubWebsite.
These are ...

1. Create a structure to your website by adding Sections, and adding Pages to these Sections, and

2. Adding content to the Pages.

For example, you may create a website with a full page image slideshow on the Home Page.
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6.2 Website settings

Website settings allow you to choose the styling of the website pages, and add organisation contact
details and links to Facebook and Twitter.

To amend Website settings

1. On the File menu, click Settings.

The options are categorised into 'pages' accessed by clicking an appropriate link in the left hand
column:

Website

Use Theme

You may choose which theme will be used to style the pages of the website. When you amend the
theme, this is reflected on the website immediately.

You may view a sample of each theme by clicking the View available themes link.

Use Font

You may choose which Font will be used to style the pages of the website. When you amend the
Font, this is reflected on the website immediately.

You may view a sample of each font by clicking the View font on Google Fonts website link.

Font Size (px)

You may choose the size of the lettering on the website. This size is measured in pixels, with 16px
as the normal (medium) size value.

This value represents the font size used for text in paragraphs. Headings, etc., will automatically be
scaled relative to the chosen Font Size.

Golf Club

Address

Enter the Address of your organisation if you wish this to be displayed in the footer of each page.

Telephone

Enter the Telephone number of your organisation if you wish this to be displayed in the footer of
each page.

E-mail Address

Enter the E-mail Address of your organisation if you wish this to be displayed in the footer of each
page.

Social Media

Link to Facebook

Tick the Link to Facebook box if you wish to show a Facebook link in the footer of each website
page. Enter your organisation's facebook link in the www.facebook.com/ box.

Link to Twitter

Tick the Link to Twitter box if you wish to show a Twitter link in the footer of each website page.
Enter your organisation's Twitter link in the twitter.com/ box.
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Link to Instagram

Tick the Link to Instagram box if you wish to show an Instagram link in the footer of each website
page. Enter your organisation's Instagram link in the www.instagram.com/ box.

Options

Tick the When entering text into paragraphs, highlight unrecognised words in blue (English
Dictionary) box if you wish to have unrecognised words highlighted in blue whilst you are entering text
into web pages. The words will be checked against an English language dictionary.
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6.3 Creating structure to your website

Sections

A section is one or more pages on your website that are accessed from a top-level link along the
main website menu. A section might be titled “Home”, or “Golf Course”, or “Contact Us”, for
example.

When you add a section, a new link is added to the main menu on your website.

Each section requires one or more Pages, which will be used to display the content for that
section. 

Pages

Each page that you create is assigned to one of the site’s Sections. 

You will need one or more pages on the website, as content may only be added to Pages, not
directly to Sections.

When two or more pages are added to the same section, their page titles will appear as a drop-
down menu for that section on the website.

Items

Items are elements that you add to each page to provide the content. Items may be Pictures, Text,
etc.
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6.4 Addng content to your website

You may add content to a Page on the website by adding one or more Items to that page. 

An item may be any one of 

A heading

Paragraph(s) of text

A Picture

A combination of a picture and some text

Data laid out in a Table

A PDF document that may be downloaded from the website

A link to another web page or website

A location map (using Google Maps)

Club Notices

A Video on the YouTube website

A Contact Us form

Club Open Competitions (Entry and/or Results)

Web page from another website

A Weather Forecast

These items, once added to a Page, may be edited, removed or reordered on the Page at any time.

When adding text, any words not found in a Standard English dictionary are highlighted in blue,
indicating a possible spelling error.

When adding pictures, these will automatically be resized to any one of four chosen widths, ensuring
efficient performance of the website, whilst also maintaining the original pictures’ aspect.
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6.5 Create a website with a full page picture on the Home Page

These notes suggest how you might create a website where the top of the home page consists of a
full-page slide-show of images, such as this example:

For this, you will need a minimum of two high-quality photographs to display on your page. Their size
must be a minimum of 1600 pixels wide by 1200 pixels high (or for a 'letterbox' style, a minimum of
1600 pixels wide and 640 pixels high).

To create a website with a full picture slide-show on the front page

1. In ClubWebsite program, select File drop-down menu, then Settings.

2. Choose Website section.

3. In the Use Theme box, select any one of the themes named "Modern". Click OK.

4. Click Site Map button and double-click the first page that you have in your 'Home' section.

5. If you already have a Picture Carousel on the page, delete this.

6. In the left-hand column, click Add a New Item. Select Picture Carousel and click OK.

7. In On Website, show images as size select one of Full Size or Letterbox Full.

8. Click Add Pictures and add two or more images to the Carousel and click OK.

9. Move the Carousel to the top item (i.e., first item) on the page.

Adding a message to each slide

If you wish to add messages to the slides (such as the WELCOME to our lovely course in the example
above), you can edit the Picture Carousel and use the Overlay Text option to add messages to any or
each slide. You may add a different message to each slide, if you wish.
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7 Sections

7.1 Introduction - Sections

A section is one or more pages on your website that are accessed from a top-level link along the main
website menu. A section might be titled “Home”, or “Golf Course”, or “Contact Us”, for example.

When you add a section, a new link is added to the main menu on your website.

Each section requires one or more Pages, which will be used to display the content for that section. 

See Also

Add a new Section

Edit a Section

Delete a Section

Change the order Sections are listed

Edit Pages in a Section
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7.2 Add a new Section

To add a new Section

To add a section to the website, do the following:

1. Do one of the following:

On the Sections drop-down menu, click Add a New Section

In the left-hand column, in the Places box, click Sections. In the Section Tasks box, click Add a
New Section.

2. Enter the details of the website section.

3. Click OK button to add the section to the website.

Notes

As soon as you click OK button, the section will be added to the website.

The new section will be added as the right-most item on the website menu. You may re-order the
sections to suit your preferences.

See Also

Edit a Section

Delete a Section

Change the order Sections are listed

Edit Pages in a Section
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7.3 Edit a Section

To edit a Section

To amend a section of the website, do the following:

1. Do one of the following:

On the Sections drop-down menu, click Edit Section. Choose the section to edit.

In the left-hand column, in the Places box, click Sections. Highlight the section to be edited in the
right-hand pane with a single click. In the Section Tasks box, click Edit Section.

2. Update the details of the website section.

3. Click OK button to update the section on the website.

Notes

As soon as you click OK button, the section will be updated on the website.

See Also

Add a new Section

Delete a Section

Change the order Sections are listed

Edit Pages in a Section
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7.4 Section information

Adding or editing a Section

1. In the Type of Section list, select the type of section you are adding (see below).

2. In the Link Title box, enter the description that will be used for the link in the website menu.

3. If adding a section of type Link to another website, enter the website address that the link will direct
website users to, into the URL of External Website box. This must be the full web address, starting
with "http" or "https". 
For example: http://www.MasterScoreboard.co.uk

4. Tick the Hide Section from website menus box if you do not wish the section to be included in the
website menus. Pages within the hidden section can still be linked from another page on the
website. Consider adding a Section Table of Contents item to another page to offer links to all pages
in the hidden section from the other page.

Types of Sections

The following types of sections may be added to the website:

a. Home Page
This will provide a link to the home page of the club website.

b. Members Area
This will provide a link to the Member's area of the club website. The content and structure for this
area will automatically be created, including links to all of the members' information available
through Master Scoreboard. You may add Custom Pages and Links to another website to this
section. When you do, the pages will be listed under a menu titled Information.

c. Custom Page(s)
One or more pages with your own content.

d. Link to another website
This will provide a link to an external website of your choosing. This could be another website for
your organisation, for example.

See Also

Add a new Section

Edit a Section

Delete a Section

Change the order Sections are listed

Edit Pages in a Section

http://www.MasterScoreboard.co.uk
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7.5 Delete a Section

To delete a Section from the website

To remove a section from the website, do the following:

1. Do one of the following:

On the Sections drop-down menu, click Delete Section. Choose the section to delete.

In the left-hand column, in the Places box, click Sections. Highlight the section to be deleted in
the right-hand pane with a single click. In the Section Tasks box, click Delete Section.

2. Click YES button to delete the section from the website.

Notes

As soon as you click OK button, the section will be removed on the website.

See Also

Add a new Section

Edit a Section

Change the order Sections are listed

Edit Pages in a Section
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7.6 Change the order Sections are listed

The sections will be shown in the website menu in the order that they are listed in the "sections" list
(Order 1 being the leftmost menu item, order 2 the second item from the left, etc).

You may elect to change the ordering of sections to your preference.

To change the order Sections are listed

To change the order Sections are displayed on the website, do the following:

1. Do one of the following:

On the main toolbar, click the Sections button.

In the left-hand column, in the Places box, click Sections. 

2. Highlight a section to be moved up or down the order.

3. Do one of the following:

In the left-hand column, click Move Section Up or Move Section Down, or

Whilst holding down the SHIFT key, press the UP ARROW or DOWN ARROW keys on the keyboard.

Notes

As soon as you move a section up or down in the list, the order will be reflected on the website.

See Also

Add a new Section

Edit a Section

Delete a Section

Edit Pages in a Section
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7.7 Edit Pages in a Section

The 'Home Page' and "Custom Page(s)' sections may have 1 or more pages associated with them.
The pages can hold content for the public pages of the website.

To edit pages within a Section

If the section is of type 'Home Page' or 'Custom Page(s)';

1. Do one of the following:

On the Sections drop-down menu, click Manage Pages in Section. Choose the required
section,

In the left-hand column, in the Places box, click Sections. In the Sections Tasks box, click
Manage Pages in Section, or

On the main toolbar, click Site Map button. In the Site Map list, double-click the required section.

See Also

Add a new Section

Edit a Section

Delete a Section

Change the order Sections are listed
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8 Pages

8.1 Introduction - Pages

Each page that you create is assigned to one of the site’s Sections. 

You will need one or more pages on the website, as content may only be added to Pages, not directly
to Sections.

When two or more pages are added to the same section, their page titles will appear as a drop-down
menu for that section on the website.

See Also

Add a new Page

Edit the title of a Page

Edit the contents of a Page

Delete a Page

Create a copy of a Page

Change the order pages are listed within their section

Move a Page to another Section
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8.2 Add a new Page

To add a new Page to a Section

To add a page to a 'Home Page' or Custom Page(s)' section of the website, do the following:

1. Do one of the following to chose the Section:

On the Sections drop-down menu, click Manage Pages in Section. Choose the required
section,

In the left-hand column, in the Places box, click Sections. In the Sections Tasks box, click
Manage Pages in Section, or

On the main toolbar, click Site Map button. In the Site Map list, double-click the required section.

2. Do one of the following:

In the left-hand column, click Add a new Page, or

Press the INSERT Key on the keyboard.

3. Enter the Page Title for this page. Where a section has more than one Page, the Page Title will be
displayed in the sub-menu.

4. Click OK button to add the section to the website.

Notes

As soon as you click OK button, the page will be added to the website.

The new page will be added as the last item on the website sub-menu. You may re-order the pages
to suit your preferences.

See Also

Edit the title of a Page

Edit the contents of a Page

Delete a Page

Create a copy of a Page

Change the order pages are listed within their section

Move a Page to another Section
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8.3 Edit the title of a Page

To edit the title of a Page (as shown in the site menu)

To amend a page title (i.e. the description for the page in the site menu), do the following:

1. Do one of the following:

On the Sections drop-down menu, click Manage Pages in Section. Choose the required
section,

In the left-hand column, in the Places box, click Sections. In the Sections Tasks box, click
Manage Pages in Section, or

On the main toolbar, click Site Map button. In the Site Map list, double-click the required section.

2. Highlight the page to be amended in the list of pages in the right-hand column with a single click,
then in the left-hand column click Edit Page

3. Enter the Page Title for this page and then click OK.

Notes

As soon as you click OK button, the page title will be updated on the website.

See Also

Add a new Page

Edit the contents of a Page

Delete a Page

Create a copy of a Page

Change the order pages are listed within their section

Move a Page to another Section



39Pages

© HandicapMaster Limited 2023

8.4 Edit the contents of a Page

The 'Home Page' and "Custom Page(s)' sections may have 1 or more pages associated with them.
The pages can hold content for the public pages of the website.

To edit the contents of a Page

If the page is in a section is of type 'Home Page' or 'Custom Page(s)';

1. Do one of the following:

On the Pages drop-down menu, click Edit Page Contents. Choose the required section and
then page to be edited, 

On the main toolbar, click Site Map button. In the Site Map list, double-click the required page.

You may now add, edit or delete items on the page. To edit an item, double-click over the item in the
list.

See Also

Add a new Page

Edit the title of a Page

Delete a Page

Create a copy of a Page

Change the order pages are listed within their section

Move a Page to another Section
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8.5 Delete a Page

To delete a page from the website

To remove a page from the website, do the following:

1. Do one of the following:

On the Sections drop-down menu, click Manage Pages in Section. Choose the required
section,

In the left-hand column, in the Places box, click Sections. In the Sections Tasks box, click
Manage Pages in Section, or

On the main toolbar, click Site Map button. In the Site Map list, double-click the required section.

2. Highlight the page to be amended in the list of pages in the right-hand column with a single click,
then do one of the following:

in the left-hand column, click Delete Page, or

Press the DELETE key on the keyboard.

3. Click YES button to delete the page from the website.

Notes

As soon as you click OK button, the page will be removed on the website. 

See Also

Add a new Page

Edit the title of a Page

Edit the contents of a Page

Create a copy of a Page

Change the order pages are listed within their section

Move a Page to another Section
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8.6 Create a copy of a Page

To create a copy of a Page (i.e. duplicate a Page)

To create a copy of a page:

1. Do one of the following:

On the Pages drop-down menu, click Create Copy of Page. Choose the required page,

On the main toolbar, click Pages button. Select the section where the page is currently located.
Highlight the page in the list and click Create Copy of Page in the tasks list.

A copy of the page will be appended to the section containing the existing page.

See Also

Add a new Page

Edit the title of a Page

Edit the contents of a Page

Delete a Page

Change the order pages are listed within their section

Move a Page to another Section
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8.7 Change the order Pages are listed within their Section

The pages will be shown in the website menu in the order that they are listed in the "pages" list.

The page with 'Order' of 1 will be the first page viewed by a visitor to the website when they click the
Section link. Order 2 will be the second page, etc.

The page with ''Order' of 1 will be listed at the top of the sub-menu on the website, when there are more
than one page in the section, etc.

You may elect to change the ordering of pages to your preference.

To change the order Pages are listed

To change the order pages are displayed within their Section on the website, do the following:

1. Do one of the following:

On the Sections drop-down menu, click Manage Pages in Section. Choose the required
section,

In the left-hand column, in the Places box, click Sections. In the Sections Tasks box, click
Manage Pages in Section, or

On the main toolbar, click Site Map button. In the Site Map list, double-click the required section.

2. Highlight a page to be moved up or down the order.

3. Do one of the following:

In the left-hand column, click Move Page Up or Move Page Down, or

Whilst holding down the SHIFT key, press the UP ARROW or DOWN ARROW keys on the keyboard.

Notes

As soon as you move a page up or down in the list, the order will be reflected on the website.

See Also

Add a new Page

Edit the title of a Page

Edit the contents of a Page

Delete a Page

Create a copy of a Page

Move a Page to another Section
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8.8 Move a Page to another Section

To move a Page to another Section

To change the section to which a Page is assigned:

1. Do one of the following:

On the Pages drop-down menu, click Move Page to another Section. Choose the required
page,

On the main toolbar, click Pages button. Select the section where the page is currently located.
Highlight the page in the list and click Move Page to another Section in the tasks list.

2. Choose the new section to host the page.

See Also

Add a new Page

Edit the title of a Page

Edit the contents of a Page

Delete a Page

Create a copy of a Page

Change the order pages are listed within their section
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9 Items

9.1 Introduction - Items

Items are elements that you add to each page to provide the content. Items may be Pictures, Text, etc.

The following types of items may be added to custom pages on the website:

Heading

Text

Picture

Picture Carousel

Text alongside a Picture

Table of data

Document

Page Link

Location Map

List of Notices

YouTube Video

A 'Contact us' form

Club Open Competitions (Booking)

Club Open Competitions (Results)

Club Open Knock-outs

External Web page in an IFRAME

Weather Forecast

General Bookings

Section Table of Contents

See Also

Add a new Item to a Page

Edit an Item on a Page

Delete an Item from a Page

Change where an Item appears on a Page
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9.2 Add a new Item to a Page

To add a new Item to a Page

1. To select the Page, on the main toolbar, click Site Map button. In the Site Map list, double-click the
required Page.

2. Do one of the following:

In the left-hand column, click Add a new Item, or

Press the INSERT Key on the keyboard.

3. Chose the type of item to add to this page.

4. If adding a second or subsequent item to a page, choose whether the item should be inserted 
Above or Below the currently selected item.

5. Click OK.

6. Enter the details required for this item and click OK.

Notes

As soon as you click OK button, the item will be added to the page on the website.

You may re-order the items to suit your preferences.

See Also

Edit an Item on a Page

Delete an Item from a Page

Change where an Item appears on a Page
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9.3 Edit an Item on a Page

To edit an Item to a Page

1. To select the Page, on the main toolbar, click Site Map button. In the Site Map list, double-click the
required Page.

2. On the right-hand pane, double-click the item that you wish to change.

3. Enter the details required for this item and click OK.

Notes

As soon as you click OK button, the item will be updated on the website.

See Also

Add a new Item to a Page

Delete an Item from a Page

Change where an Item appears on a Page
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9.4 Delete an Item from a Page

To delete an Item from a Page

1. To select the Page, on the main toolbar, click Site Map button. In the Site Map list, double-click the
required Page.

2. On the right-hand side, highlight the item to be deleted with a single click.

3. Do one of the following:

In the left-hand column, click Delete Item, or

Press the DELETE Key on the keyboard.

Notes

As soon as you click OK button, the item will be deleted from the page on the website.

See Also

Add a new Item to a Page

Edit an Item on a Page

Change where an Item appears on a Page
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9.5 Change where an Item appears on a Page

The Items will be shown on the Page on the website menu in the order that they are listed (top to
bottom).

You may elect to change the ordering of items to your preference.

To change the order an item appears on a Page

1. To select the Page, on the main toolbar, click Site Map button. In the Site Map list, double-click the
required Page.

2. On the right-hand side, highlight the item to be moved up or down, with a single click.

2. Do one of the following:

In the left-hand column, click Move Item Up or Move Item Down, or

Whilst holding down the SHIFT key, press the UP ARROW or DOWN ARROW keys on the keyboard.

Notes

As soon as you move an item up or down in the list, this will be reflected on the website.

See Also

Add a new Item to a Page

Edit an Item on a Page

Delete an Item from a Page
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9.6 Types of Items

9.6.1 Headings

A Heading item is an item on a page that is displayed as a heading or sub-heading.

To enter a heading onto a Page:

1. Elect to add a new item to a page, selecting a Heading item.

2. In the Heading Text box, enter the wording you would like to display on the website.

3. Choose one of 

Show as Heading, or

Show as Sub-Heading.

4. in the Alignment box, select Left, Center or Right to align the heading on the web page as required.

Notes

A Sub-Heading will typically be shown in a smaller font with less emphasis than a Heading,
depending upon the chosen website theme.

9.6.2 Paragraph(s) of Text

A Text item is an block of text displayed as a paragraph or paragraphs of text.

As you enter text into the Page Text box, any words not commonly found in an English (British)
dictionary will be highlighted in blue.

To enter a block of text onto a Page:

1. Elect to add a new item to a page, selecting a Text item.

2. In the Page Text box, enter the wording you would like to display on the website.

3. in the Alignment box, select Justify for the text to be displayed full width and fully justified, or Center
for the text to be displayed centered on the page.

Turn off highlighting of unrecognised words in blue

You may turn off the highlighting of unrecognised words in blue as follows:

1. Do one of the following:

Select File drop-down menu, then Settings, or

Click the Settings button on the main toolbar.

2. In the left hand column, click Options.

3. Un-tick When entering text into paragraphs, highlight unrecognised words in blue (English
Dictionary) box.

4. Click OK.
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Notes

You may use a carriage return to space out more than one paragraph, if required. Alternatively, each
paragraph could be added as its own Text item.

9.6.3 Pictures

A Picture item is an image that you can upload to the website.

Only picture files of type JPEG (*.jpg or *.jpeg) or PNG (*.png) may be uploaded.

To enter a Picture onto a Page:

1. Elect to add a new item to a page, selecting a Picture item.

2. Click the Select Image button and navigate to the Picture file on your computer. Click Open when you
have located the Picture file.

3. In the On website, show image as size list, select the size that you would like the Picture to be
displayed on the website. Choose one of

Thumbnail (120 pixels wide)

Small (250 pixels wide)

Medium (500 pixels wide)

Large (800 pixels wide)

The picture will be sized according to the selection, based upon the chosen width. The aspect ratio will
be maintained, so that the picture is not distorted out of shape.

4. Optionally, rotate the image 90 degrees clockwise by clicking the Rotate button. Repeat this to flip
the image vertically.

See Also

Picture Carousel

Text alongside a Picture

9.6.4 Picture Carousel

A Picture Carousel item is a series of images that you can upload to the website, that when displayed
on the web page, are displayed in sequence.

One picture at a time is displayed, changing picture every 5 seconds.

Only picture files of type JPEG (*.jpg or *.jpeg) or PNG (*.png) may be uploaded.

To enter a Picture Carousel onto a Page:

1. Elect to add a new item to a page, selecting a Picture Carousel item.

2. In the On website, show images as size list, select the size that you would like the pictures to be
displayed on the website. The pictures that you add to the carousel will need to be at least as big as
the pixel size selected.
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3. Click Add Pictures button.

4. Click the Add button to add a picture to the carousel. Navigate to the Picture file on your computer.
Click Open when you have located the Picture file.

5. Repeat the Add button to add further pictures to the carousel.

How to... ?

... Remove an image form the Carousel?

1. Do one of the following:

Click the image in the gallery that you wish to delete. It will be highlighted with a red border. Then
click Remove button on the toolbar, or

Right-click over the image in the gallery that you wish to delete and click Remove in the pop-up
menu.

... Change the order the pictures are displayed on the webpage?

Pictures will be displayed on the website in the order that they are shown in the gallery (left-most
picture first). To change the order:

1. Do one of the following:

Select an image (click over the image or user LEFT or RIGHT keys on the keyboard) and the
image will be highlighted with a red border. Then, on the toolbar, click Move Left or Move Right
button, or

Right-click over the image in the gallery that you wish to move and click Move Left or Move Right
in the pop-up menu.

... Overlay text over the images?

You may choose to overlay a message over the images. You may add a separate message to each
slide in the carousel. 

These messages are displayed over the centre of the image, and ware displayed in a colour of white,
so would be appropriate where the image includes darker items in the middle of the image.

1. Do one of the following:

Select an image (click over the image or user LEFT or RIGHT keys on the keyboard) and the
image will be highlighted with a red border. Then, on the toolbar, click Overlay Text button, or

Right-click over the image in the gallery that you wish to move and click Overlay Text in the pop-
up menu

2. In the Headline Message box, add the main message to be displayed. 

3. In the Secondary (supporting) line box, optionally add a second line.

... Flip a picture because it is upside down?

Depending upon the camera position when the photograph was taken, the picture may be displayed
upside down.
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1. Do one of the following:

Select an image (click over the image or user LEFT or RIGHT keys on the keyboard) and the
image will be highlighted with a red border. Then, on the toolbar, click Flip Vertically or Flip
Horizontally button, or

Right-click over the image in the gallery that you wish to move and click Flip Vertically or Flip
Horizontally in the pop-up menu.

... Rotate a picture 90 degrees because it is sideways?

Depending upon the camera position when the photograph was taken, the picture may be displayed
sideways.

1. Do one of the following:

Select an image (click over the image or user LEFT or RIGHT keys on the keyboard) and the
image will be highlighted with a red border. Then, on the toolbar, click  Rotate 90 degrees
button, or

Right-click over the image in the gallery that you wish to move and click  Rotate Image 90
degrees Clockwise in the pop-up menu

Notes

How many pictures should be added to the Carousel?

Add between 2 and 9 pictures to the carousel. The recommendation is to add between 3 to 5 pictures,
as this will provide the best compromise between providing interest to your users without making the
web page too large to download.

Some pictures I have added to the Carousel have been cropped. Why?

The carousel requires all of the pictures that it will display to be of the same size and aspect. This is to
prevent the web page continuing to resize and reshape as the web page is being viewed. To ensure
this, ClubWebsite automatically reduces pictures to the nearest best size available. If the result is not
quite the same aspect as the required size, it then crops the picture to the correct size, using the central
section of the picture.

If the cropping results in the wrong section of a picture being used in the carousel, we recommend that
you resize the picture using a suitable picture editing app before adding it to the carousel.

See Also

Pictures

Text alongside a Picture

9.6.5 Text alongside a Picture

A Text alongside a Picture item is an block of text displayed as a paragraph or paragraphs of text,
placed to the right or left of a picture.

To enter text alongside a Picture onto a Page:

1. Elect to add a new item to a page, selecting a Text alongside a Picture item.
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2. Click the Select Image button and navigate to the Picture file on your computer. Click Open when you
have located the Picture file.

3. In the On website, show image as size list, select the size that you would like the Picture to be
displayed on the website. Choose one of

Thumbnail (120 pixels wide)

Small (250 pixels wide)

Medium (500 pixels wide)

The picture will be sized according to the selection, based upon the chosen width. The aspect ratio will
be maintained, so that the picture is not distorted out of shape.

4. In the Position of Image box, select whether the Image will be displayed to the left or right of the text.

5. In the Page Text box, enter the wording you would like to display alongside the picture.

4. Optionally, rotate the image 90 degrees clockwise by clicking the Rotate button. Repeat this to flip
the image vertically.

Notes

Only picture files of type JPEG (*.jpg or *.jpeg) or PNG (*.png) may be uploaded.

As you enter text into the Page Text box, any words not commonly found in an English (British)
dictionary will be highlighted in blue.

You may use a carriage return to space out more than one paragraph, if required.

See Also

Pictures

Picture Carousel

9.6.6 Table of Data

A Table of data item is a collection of text shown in tabular form on the website.

To enter a Table onto a Page:

1. Elect to add a new item to a page, selecting a Table of data item.

2. Tick the Treat top row as header row on webpage box if you wish the first row of data that you enter
is to be shown as headings to the columns.

3. Tick the Show Borders and Gridlines on webpage box if you wish the columns and rows to be
displayed as a grid.

4. When Show Border and Gridlines on webpage box is ticked, tick Show background shading on
alternate rows in Table box to 'band'  alternate rows in the table with a background shading.

5. Enter the text that you would like displayed in a cell by clicking that cell in the grid and typing your text.

The Table Toolbar

Using the Toolbar displayed above the table, you may perform additional actions editing the table
contents.
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Table Toolbar

These include

Copy the contents of a cell or cells to another program:

1. Choose a cell or cells that you would like to copy. 

2. Click the Copy button on the toolbar, or press CONTROL & C keys on the Keyboard.

Paste text from another application (such as Excel or Word) into the Table:

1. Select the cell at the top left position that you would like to paste the text. 

2. Click the Paste button on the Toolbar, or press CONTROL & V keys on the Keyboard.

Add an additional row to the grid:

1. Choose any cell in the row immediately below the row where you would like to insert an
extra row. The cell will be shown with a highlight.

2. Click the Insert Row button on the toolbar.

Delete a row or rows from the grid:

1. Choose a cell in each of the rows that you would like to remove from the grid. The cell(s) will
be shown with a highlight. You may select more than one cell by holding the CTRL key
down as you click additional cells.

2. Click the Delete Row button on the toolbar.

Add an additional column to the grid:

1. Choose a cell in the column immediately before or immediately after the column where you
would like to insert an extra column. The cell will be shown with a highlight.

2. Click the Insert Column Before or Insert Column After button on the toolbar.

Delete a column or columns from the grid:

1. Choose a cell in each of the the columns that you would like to remove from the table. The
cells will be shown with a highlight. You may select more than one cell by holding the CTRL
key down as you click additional cells.

2. Click the Delete Column button on the toolbar.

Align the text within cells left, right or centered:

1. Choose a cell or cells that you would like to change the text alignment. The cells will be
shown with a highlight. You may select more than one cell by holding the CTRL key down
as you click additional cells.

2. Click the Align Left, Center or Align Right buttons on the toolbar.

Clear the contents of the Table:

1. Click the Clear Table button on the toolbar.

Note:

You may also access the toolbar buttons by right-clicking with the mouse over a table cell and using
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the pop-up menu.

9.6.7 Document

A Document item is a document that you upload to the website, that your visitors may download by
clicking a link.

The document file must be a file of type Portab le Document File (PDF).

To enter a Document link onto a Page:

1. Elect to add a new item to a page, selecting a Document item.

2. Click the Select Document button and navigate to the document on your computer. Click Open when
you have located the document file.

3. In the Link Description box enter the description to be used for the link to this document on the
website.

4. Tick the Show Icon and file size alongside link box if you would like the link in the web page to
include an Adobe icon and a statement of the file size alongside the link.

9.6.8 Page Link

A Page Link item is a link that you may include within a page on the website, that your visitors may click
to be taken to another page in this website, or to another website altogether.

It will be presented highlighted as a sentence introducing a link button or plain link. For example;

Read the latest news from the R&A ... [ View Now ]

When displayed as a button, the introductory text will be highlighted in bold and centered on the web
page.

To enter a Page Link onto a Page:

1. Elect to add a new item to a page, selecting a Page Link item.

2. If the link is to another page within this website;

a) Select Link to a Page within this website.

b) In the Link to Page list, select the page which you would like this link to take your site
visitors to.

3. If the link to to a different website altogether;

a) Select Link to other website.

b) In the URL of External Website Page box, enter the full page address of the other
website. The address must start with either http:// or https://.

4. In the Link is introduced with ... box, enter a suitable lead-in sentence explaining what the link is
about. For example, to introduce a link to revised rules of golf, you might enter Read the latest
updates to the Rules of Golf.

5. In the Link Text box, enter a suitable description for the link button. For example, you might enter a
description of View Now.
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6. In the Display as box, select either

Introductory text, followed by a clickable button displaying the Link text to have the link
displayed as a clickable button, or

Introductory text, followed by a plain link displaying the Link text to have the link as a plain
web page link (left aligned).

7. If you prefer the page opened when the visitor clicks the link to be in a new browser window (so they
do not lose their place in your website), tick When clicked, Link opens in new browser tab box.

9.6.9 Location Map

A Location Map item is a map provided by Google showing a selected point plotted on the Map. This
could be used to show the location of your club, for example.

To enter a Location Map onto a Page:

1. Elect to add a new item to a page, selecting a Location Map item.

2. In the Title given to point plotted on map box, enter a description (heading) for this map.

3. In the Place Name or Address box, enter the name of your club. If this is not a place name known to
Google (and therefore the result is a map of the world when viewed on the website), then enter the
address.

9.6.10 List of Notices

A List of Notices item is an embedded list of notices (e.g. news items) that may be maintained using
ClubWebsite, or may be entered through the Master Scoreboard website Control Panel.

To enter a list of Notices onto a Page:

1. Elect to add a new item to a page, selecting a List of Notices item.

2. Choose whether to embed Public Notices or Members Notices in the web page.The list of notices
will immediately be added to the page (shown as [CLUB NOTICES - <Public or Members> Notices]
in the page items list).

3. Tick Hide Notices item on website when there are no notices to display box if you do not wish to
display the 'Notices' heading (and message that no notices exist), when there are no notices to be
displayed.

9.6.11 YouTube Video

A YouTube Video item is a video hosted on the YouTube service, embedded within a 'window' on the
Page.

To enter a YouTube Video onto a Page:

1. Elect to add a new item to a page, selecting a YouTube Video item.

2. In the YouTube Video SHARE Address box, enter the address of the video on YouTube. 
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You may locate this by clicking the 'Share' link on the web page containing the Video on the YouTube
website. The address will look something like this:
https://youtu.be/FHfVmvJ3_OU

Copy and paste this address from the YouTube website into this box.

3. Chose the Size that you would like the Video image to be displayed in the page.

4. If you wish viewers to be able to select the Full Screen option and view the video full screen, tick the
Allow video to be viewed full screen box.

9.6.12 'Contact Us' Form

A Contact Us form  item is an item on a page that offers the option for a visitor to send a message to the
club by email.

To enter a heading onto a Page:

1. Elect to add a new item to a page, selecting a 'Contact us' form item.

2. In the E-mail address to receive Contact messages box, enter the email address where you would
like to receive the messages to. If you would like more than one recipient to receive the visitor's
message, enter all email addresses, each separated with a comma.

Notes

Be sure to test this on the website page, to ensure that messages are successfully received.

9.6.13 Club Open Competitions (Booking)

A Club Open Competitions (Booking) item is an embedded list of competitions open to visitors that
have been uploaded to the Master Scoreboard website using HandicapMaster.

If used in conjunction with the HandicapMaster 'Club Open Bookings' facility, will allow visitors to book
into the club open competitions online, paying at the time of their booking.

To enter a Club Open Competitions (Booking) list onto a Page:

1. Elect to add a new item to a page, selecting a Club Open Competitions (Booking) item.

The list of currently available open competitions will immediately be added to the page (shown as
[CLUB OPENS - List of competitions for booking] in the page items list). 

9.6.14 Club Open Competitions (Results)

A Club Open Competitions (Results) item is an embedded list of competition results, published to
Master Scoreboard using HandicapMaster, that were marked as open to visitors.

To enter a Club Open Competitions (Results) list onto a Page:

1. Elect to add a new item to a page, selecting a Club Open Competitions (Results) item.

The list of currently available open competitions will immediately be added to the page (shown as
[CLUB OPENS - Competitions results] in the page items list). 

https://youtu.be/FHfVmvJ3_OU
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9.6.15 Club Open Knock-outs

A Club Open Knock-outs item is an embedded list of Match-play Knockouts, published to Master
Scoreboard using HandicapMaster, that were marked as open to visitors.

Website visitors are able to select a Knock-out draw from the list and view the draw, with match results
if published.

To enter a Club Open Knock-outs list onto a Page:

1. Elect to add a new item to a page, selecting a Club Open Knock-outs item.

The list of currently available open knock-out draws will immediately be added to the page (shown as
[CLUB OPENS - Match-Play Knockouts] in the page items list). 

9.6.16 Web Page in IFRAME

A Web Page in IFRAME item is an item on a page that displays a page from another website,
embedded within a 'window' on the Page.

To enter a Web Page in an IFRAME onto a Page:

1. Elect to add a new item to a page, selecting a Web Page in IFRAME item.

2. In the Web Page to display in IFRAME box, enter the address of the web page that you wish to show
in the window on this page. This address needs to be the complete web address, starting with 
http: or https:. For example, if you were displaying the HandicapMaster.org website home page,
you would enter http://www.handicapmaster.org.

3. If you have any specific parameters to pass in the IFRAME link, enter these into the IFRAME
Parameters box. For example, if you are embedding a YouTube video, passing a parameter of
allowfullscreen will turn on the option for visitors to view the video in full screen mode.

4. In the IFRAME Window Height (pixels) list, select the height of the window to be used on the page.
The higher the number selected, the taller the 'window' will be on the page.

5. If you wish to offer a scrollbar for the window, tick the Display Vertical Scrollbar box.

9.6.17 Weather Forecast

A Weather Forecast item is a forecast for a specified location provided by Forecast.Io.. This could be
used to show the forecast for your club, for example.

To enter a Weather Forecast onto a Page:

1. Elect to add a new item to a page, selecting a Weather Forecast item.

2. Enter the location of the point to be plotted in the Location of point plotted on map section. Enter the
Latitude and Longitude of the point to be plotted.

To determine the Latitude and Longitude of the point that you wish to base the Forecast
on:

We recommend this method of finding the Latitude and Longitude of a point on a map...

1. Visit this website:
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https://www.doogal.co.uk/LatLong.php

2. Either use the "Search for an address" and enter  the name of your nearest town 

Or locate the location  using the map

Click and hold the left mouse button to move the map

Use the scroll wheel on your mouse to zoom in or out

3. Click to add a Blue Marker to the map where you would like to fine the latitude and longitude values,

4. Read the Latitude and Longitude values by clicking on the "Enter a latitude/longitude"  on the right
hand side of the map (each as a single number).

9.6.18 General Bookings

A General Bookings item is an embedded list of facilities available to be booked, that have been
created using the HandicapMaster program.

If used in conjunction with the HandicapMaster 'General Bookings' facility, will allow visitors to book into
Casual Tee Times (and other club facilities), paying at the time of their booking.

To enter a General Bookings list onto a Page:

1. Elect to add a new item to a page, selecting a General Bookings item.

The list of currently available bookings facilities will immediately be added to the page (shown as
[GENERAL BOOKINGS] in the page items list). 

9.6.19 Section Table of Contents

A Section Table of Contents is an embedded list of page links for a chosen section, displayed like a
Table of Contents.

To avoid too many menu items, you might like to create a Table of Contents on one page that provides
links to all pages in a section that has been 'hidden' from the menus. 

To enter a Section Table of Contents list onto a page:

1. Elect to add a new item to a page, selecting a Section - Table of Contents item.

The Table of Contents will immediately be added to the page (shown as [SECTION TABLE OF
CONTENTS] in the page items list). 

https://www.doogal.co.uk/LatLong.php
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10 Club Notices

10.1 Introduction - Club Notices

Club Notices are notices of information (such as news items) that may be published on the website.

You may add and update these notices either through ClubWebsite or through the Master Scoreboard
website control panel.

When you add them through ClubWebsite, you have the choice of adding the Notices to the "Public"
web pages or to the Members' Area.

See Also:

Add a new Notice

Edit an existing Notice

Delete a Notice
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10.2 Add a new Notice

To add a notice to the website:

1. Do one of the following:

In the left-hand column, in the Places box click Club Notices, or

On the main toolbar, click the Notices button.

2. Do one of the following:

In the left-hand column, click Add a New Notice, or

Press the INSERT Key on the keyboard.

3. In the Posted By box, enter your name to identify you as the person posting the notice.

4. In the Expire Notice On box, select the date that you would like the notice to automatically be
removed from the website.

5. In the Type list, select whether to add the notice to the public web pages or to the Members' area
pages.

6. Enter the details of the notice in the Notice box.

7. Click OK to save the notice.

Notes

As soon as you click OK button, the notice will be added to the website.

See Also:

Edit an existing Notice

Delete a Notice
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10.3 Edit an existing Notice

To edit an existing notice:

1. Do one of the following:

In the left-hand column, in the Places box click Club Notices, or

On the main toolbar, click the Notices button.

2. Double-click the notice to be edited in the right-hand pane.

3. In the Posted By box, enter your name to identify you as the person posting the notice.

4. In the Expire Notice On box, select the date that you would like the notice to automatically be
removed from the website.

5. In the Type list, select whether to add the notice to the public web pages or to the Members' area
pages.

6. Enter the details of the notice in the Notice box.

7. Click OK to save the notice.

Notes

As soon as you click OK button, the notice will be updated on the website.

See Also:

Add a new Notice

Delete a Notice
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10.4 Delete a Notice

To delete a notice:

1. Do one of the following:

In the left-hand column, in the Places box click Club Notices, or

On the main toolbar, click the Notices button.

2. Highlight the notice to be deleted in the right-hand pane with a single click.

3. Do one of the following:

In the left-hand column, click Delete Notice, or

Press the DELETE Key on the keyboard.

Notes

As soon as you click YES button, the notice will be removed from the website.

See Also:

Add a new Notice

Edit an existing Notice
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11 Userids and Passwords

11.1 Introduction

You may add additional Users with their own passwords to log into  ClubWebsite.

Contents

Add a user

Remove a User

Change a Password

Deactivate or reactivate a User

Properties of a User
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11.2 Add a User

To add a User to ClubWebsite

1. On the File menu, select Users

2. Click Add... button

3. Select the properties of this user.

Note

You may only access the Users option if you are logged in as the Admin user.

Names for Users may only consist of letters A to Z, Numbers 0 to 9 and/or the hyphen or hash
characters.
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11.3 Remove a User

To remove a User from ClubWebsite  

1. On the File menu, select Users

2. Select a User in the ClubWebsite Users list

3. Click Remove button

Notes:

You may only access the Users option if you are logged in as the Admin user.

The ADMIN user may not be removed

It is not possible to remove the User who is currently logged on
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11.4 Change the Password

The Password is the password that must be entered on the opening screen in order to gain access to
ClubWebsite. 

To change the Password 

1. On the File menu, click Change Password.

2. In the Old Password box, type the current (existing) password, if one exists. 

3. In the New Password box, enter the new password. 

4. In the Confirm New Password box, repeat the new password.

5. Click OK

 Note

The following rules apply to Passwords:

Passwords must be at least 4 characters long

Any character, number or symbol can be used

Passwords are not case-sensitive.

To Remove (clear) the Password

It is possible to reset or remove the password by:

1. In the Old Password box, type the current (existing) password, if one exists. 

2. Clear (leave empty) the New Password and Confirm New Password boxes. 

To reset a User's Password

1. On the File menu, click Users.

2. Highlight a User in the ClubWebsite Users list 

3. Click Change the password of User '<Name>' link.

Note

You may only access the Users option if you are logged in as the Admin user.

If you have lost the Admin User Password

In the event of a lost or forgotten password, please contact the supplier.
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11.5 Deactivate or reactivate a User

To activate or deactivate a User from ClubWebsite  

1. On the File menu, select Users

2. Select a User in the ClubWebsite Users list

3. Click Properties button

Notes:

You may only access the Users option if you are logged in as the Admin user.

The ADMIN user may not be deactivated.
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11.6 Properties of a User

The following Properties of a User Account may be chosen:

User Name

The Name the User.

Use this Name to log on with this User. 

The name may only consist of letters A to Z, 0 to 9, hyphen or hash letters.

Is Active User (may be used to Log on)

Whether this Userid may be used to Log into ClubWebsite.
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12 Analysing Website Usage

12.1 Analysing Page Views

You may view and analyse which pages on the website are being viewed regularly. This may help you
to design the layout of the sections and pages for optimum effect.

To view how many times each page has been viewed in the last 60 days

1. On the Statistics menu, select Number of Page Views (by Page)

Note

Pages that have been view in the member's area, for non-custom pages, are listed as one total.

Statistics are gathered based upon an internal page "ID" for each page. In the situation where a
page is deleted from the site and a different page is created in its place, this may result in the same
ID being allocated to the new page. For this reason, the statistics for the previous page may be
included in the records for the new page.

To view how many times pages has been viewed (per day) in the last 60 days

1. On the Statistics menu, select Number of Page Views (by Date)

Notes

Statistics are gathered based upon page views, not hits. That is, one count is added each time a
whole page is displayed (not one count per item accessed).

Page accesses by the common search engines when cataloging the site, for example Google, are
excluded from the Statistics.
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13 Keeping ClubWebsite Software up to date

13.1 Introduction

The ClubWebsite Update service is an online extension of ClubWebsite that helps you keep your
ClubWebsite product up-to-date. Product updates are created by ClubWebsite to bring you the highest
levels of stab ility. Updates are also issued when additional facilities are added to ClubWebsite. These
may be the result of Customer feedback, or part of ongoing product development. 

Users with an Internet connection can check for program updates. If any are found, they can be
downloaded and installed by ClubWebsite automatically. 

Those running ClubWebsite on a computer with a broadband Internet connection (an 'always-on'
connection) may like to configure ClubWebsite to automatically check for updates each time
ClubWebsite is started.

Contents

Check for Program Updates

Automatically update software
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13.2 Check for Program Updates

To run a check for Program Updates

1. On the Help menu, select Check for Updates Online.

2. If you wish ClubWebsite to check for available updates automatically each time ClubWebsite is
started, tick the Check each time ClubWebsite is started on this Computer box.

3. Click Check for Updates Now button to check, download and install any program updates
available. 

Notes:

This option requires an active Internet Connection.

For support purposes, the registered Organisation Name and Program Version number currently
being used will be passed to the HandicapMaster web site when the check for updates is run.
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13.3 Automatically update ClubWebsite software

To configure ClubWebsite to automatically install program updates when available

1. On the Help menu, select Check for Updates Online

2. Tick the Check each time ClubWebsite is started on this Computer box.

Notes:

This option requires that an Internet connection is available when ClubWebsite is started.
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